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About this Book 

This Participant Handbook is designed to enable training for the Compositor Qualification Pack (QP) 

with Ref. ID MES/ Q 3505. There are 4 National Occupational Standards (NOS) under this 

qualification pack. Each National Occupational (NOS) is covered across 7 Units in this book.  

Key Learning Objectives for every NOS mark the beginning of the Unit for that NOS. In Table of 
Contents, you will find the module names with their corresponding NOS code.  The symbols used in 
this book are described below. 
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Key Learning Outcomes  

At the end of this module, you will be able to: 

1. Explain the key features of the Media and Entertainment sector 

2. Discuss various processes and products of Media & Entertainment sector 

3. Learn about the role of Compositor in industry. 

4. Identify the minimum requirement to become a certified Compositor. 

5. Describe the work area of Compositor. 

6. Find the opportunities available for Compositor. 
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UNIT 1.1: Introduction to Media & Entertainment 

 

Unit Objectives 

At the end of this unit, you will be able to:  

1. Describe the media and entertainment industry in India 

2. Describe the growth expected in the media & entertainment industry 

3. Explain the various products and processes of the industry 

4. Identify some keywords used in the industry 

 

1.1.1 Media and Entertainment Sector in India 

The Indian media and entertainment (M&E) sector is one of the biggest in the world. It is placed as 

14th largest in the world. This sector is 1.7% of Indian GDP and expected to be 2.2% of GDP with INR 

4.5 lakh crores in 2022. The sector employs 9.3% of the workforce of our country and we are 

expecting it to be 17% till the end of 2017 

From 2014 to 2018 Media and Entertainment sector has grown by approximately 11 percent CAGR 

which makes Media and Entertainment sector INR 1.43 trillion industry. It is estimated that Indian 

Media and Entertainment market will flourish to CAGR of 13.1% in FY 18-23 reaching at INR 2.66 

trillion. The industrial performance of M&E sector is given in next figure. 

 

Figure 1.1. 1 Revenue of M&E Industry 

In 2018, digital advertising business grew 35% as compared to 2017. Another high growth sub-sector 

is Gaming which grew by 35.1% in FY 2018 as compared to FY 2017. The projected growth of 

industry for FY 2018 to 2023 is given in next figure. 
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Figure 1.1. 2 Projected growth of M&E Sector 

India is one of the largest broadcasters in the world with approximately 800 TV channels, 242 FM 

channels and more than 100 community radio networks working at present. Bollywood, the Indian 

film industry is the largest producer of films around the globe with 400 production and corporate 

houses involved. 

The Government of India keeps on pushing the Media and Entertainment industry by launching 

various schemes such as digitizing the cable TV to fill greater institutional funding, raising the 

Foreign investment from 74 per cent to 100 per cent in cable and DTH satellite platforms. 

Government has also allotted industry status to the film industry for easy finance. 

 

1.1.2 Employability in Media and Entertainment Sector 

The Media & Entertainment sector employs 11-12 lakh people directly (as per 2017 reports) and if 
we consider indirect employments as well then count goes to 35-40 lakh people. The Media sector is 
highly dependent on advertising revenues and performance of Industry for economy outlook. This 
sector was having 4 lakhs workforce in 2013 and we expect it to reach 13 lakhs by 2022 which 
means employing 9 lakhs of additional employment in the period of 2013-22. 
 

• 1/4th of the people employed in Media and Entertainment sector are from film industry. 

• The Media & Entertainment sector has about 4.60 lakhs people employed, and is projected to 

grow at the rate of 13 % to reach 7.5 lakhs by 2017. 

• The Media and Entertainment sector which is expected to grow at rate of 13.1 % by 2023 which 

means to reach 2.7 lakh crore of business for skilled professionals.  

• Film & Television sector has a major portion of the workforce employed in media and 
entertainment. Digitization activities being done in both films and television arena are the key 
player for this demand. 
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Figure 1.1. 3 Employments in Different Sectors of Media and Entertainment 

1.1.3 Evolution of Media and Entertainment Sector 

• Radio broadcasting came by Radio Club of Bombay in 1923 in India under the British rule. 

• All India Radio (AIR), one of the largest radio networks in the world, started working in 1936. 

• Doordarshan (DD) started the era of TV on Sept 15, 1959 in India. 

• The Indian economy was closed until 1990, and no private player was allowed to enter the space 

In the 1990s, the Indian film industry was completely fragmented 

• BBC launched its national service in 1995 

• In 1999, the government allowed private Indian Firms to set up their FM stations on a license 

fee basis 

• In May 2000, as part of Phase I of radio broadcast licensing, the auction was conducted and 37 

licenses were issued, out of which 21 are operational in 14 cities 

• Approximately 1000 TV channels and 1052 radio stations are expected to be working by 2022. 
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1.1.4 Major Subsector and Segments 

• The Indian M&E industry comprises several sub-sectors, such as television, radio, print media 

(including newspapers and magazines), films, animation and visual effects (VFX), Sound & Music, 

Amusement & Theme Parks, Art & Culture, and Event Management/Live Performances. 

• Advertising industry is the major revenues generating part of the industry and the growth of the 

sector decides the overall growth of the industry. 

• Although there is not much to export from this industry but imports have a considerable share 

in the economy like imports of newsprints, set-top boxes and antennae. 

 

 

Figure 1.1. 4 Media and Entertainment Sector 

 

• The industry is specific to cultural and ethnic backgrounds, and is organized around specific 

hubs that specialize in output for a given population segment. For example, the Mumbai 

film industry (Bollywood) is a key film hub in the country. A similar hub also exists in South 

India.  
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Figure 1.1. 5 Media and Entertainment Sector Growth Rates expected in 2016-2021 

1.1.5 Sector Specific Terms Used in This Book 

Animatic: A series of images edited together with dialogues and sound is called animatic. 

Compositing: Combining layers of images/elements into a single frame is called composting. 

Composition: Positioning character with respect to the background and camera is called 

composition. 

Creative Brief: A document that captures the key questions for the production including the vision, 

objective of the target audience, budgets, project, milestones, timelines and stakeholders is 

called creative brief. 

Key Frame: Key poses that start and end poses for a particular animation sequence are called key 

frames.  

Modeling: Creation of three-dimensional models for animation using a specialized software is called 

modelling. 

Rendering: Conversion of three-dimensional models into two-dimensional images with 3D effects is 

called rendering. 

Rigging: Process of adding joints to a static three-dimensional model to aid movement during posing 

is called rigging. 

2D animation: Moving pictures in a two-dimensional environment is called 2D animation like in 

computerized animation software. 

3D animation: 2D animation with depth is called 3D animation. Examples include video games such 

as Halo and Madden Football. 

Animation:  Sequential play of various inter-related frames is called animation. 

Anticipation: Anticipation are created through the preparation of an action. 
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Aspect Ratio: The width to height ratio of a tv picture is called aspect ratio. 

Background Painting: An artwork done in the background of an animation is called background 

painting. 

CGI (Computer Generated Imagery): Creation of Figures, settings, or other material in the frame 

using computer software is called CGI. 

Clean-Up: The process of refining the rough artwork of 2D animation is called Clean-up. 

Computer Animation: Any kind of animation created in computer is called computer animation. 

Frame: one of a series of still transparent photographs on a strip of film used in making movies or 

animations. 

Frame Rate: The rate of change of frames in an animation is called frame rate. It is measured in 

frames per second (fps). 

Graphics Tablet: This is a device used to draw sketches. 

Pixel: The smallest indivisible portion of an image is called pixel. 

Raster: Rastering is the projections of various pixels on CRT screen to form an image. 

Rotoscoping: Creation and manipulation of background images of an animation is called 

rotoscoping. This can be done manually as well as using computer software. 

Title Cards: Title cards are also called FIR of an animation. Title cards give brief information about 

the animation. 

Tween: The transition of one frame to another in animation is called tween. 

Vector: Some of the artwork is created by vectors rather than pixels. This allows cleaner and 

smoother animation because images are displayed by mathematical equation solutions. 

CEL: It is a cellulose sheet used to paint characters. In practice, it is now a day. plastic sheet in 

combination with the outline and coloring of a character, object, and/or special effect. 

 

 

Exercise-1  

Discuss the role of Media & Entertainment sector in India economy. 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 
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Exercise-2 

Discuss the employability of various sub-sectors in Media & Entertainment Sector. 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 
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UNIT 1.2: Duties and Responsibilities of Compositor 

 

Unit Objectives 

At the end of this unit, you will be able to:  

1. Learn about the role of Compositor in industry. 

2. Identify the minimum requirement to become a certified Compositor. 

3. Describe the work area of Compositor. 

4. Find the opportunities available for Compositor. 

 

 

1.2.1 Introduction to Compositor Job Role 

Compositor in the Media & Entertainment Industry is also known as a CG Compositor/ Compositing 

artist. Individuals at this job need to merge the various layers/elements created during post-

production into a final product 

 

Figure 1.2.1 Work of a compositor 

This job requires the individual to have a good understanding of the process of filmmaking and the 

principles of animation and visual effects. The individual must also know the theory and principles of 

light, shadows, exposure and color space. The individual must have a good working knowledge of 

compositing software such as Nuke, Fusion, Combustion, After Effects, Flame, Inferno and Shake. 
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Compositor or compositing artist is responsible for creating the final image after combining layers of 

materials created by other artists. Compositor receives material in the form of renderings, computer 

animations, special effects, live action, and static background. A compositor combines the material 

while enhancing light, adding motion blur, matchings blacks, adding, grains, creating convincing 

shadows, and so on. He needs to make sure that the layers match seamlessly and fit in continuation 

of the previous frame of video. A compositor needs to acquire good knowledge of computer 

graphics and 3D lightings.  

1.2.2 Job Profile of Compositor 

A compositor/compositing artist performs following tasks in the industry: 

• Determine key post-production processes that would be involved to produce the desired 

outcome and chart-out the process workflow, as per role. 

• Translate, or support senior personnel in translating, expectations into effort estimates for 

each process. 

• Prepare a work plan, for oneself or other team members if appropriate, keeping in mind the 

impact on the production budget, timelines and technical viability. 

• Gather raw footage/material and select, or assist in selecting, relevant material that can be 

used for post-production 

• Ingest, or support in ingesting, the footage and keep the material ready for the post-

production process 

• Ensure that back-ups for interim work-products are saved in the appropriate file formats, 

and take responsibility/manage others’ interim work-products as relevant to the role 

• Ensure, or supervise others in ensuring, that final work-products are prepared in 

appropriate file formats (such as mp4, avi, wmv, mpg and mov), appropriate mediums (such 

as DVD, film, tape and digital), and are compatible with intended distribution/exhibition 

mediums. 

• Analyze briefs, scripts, visual references, technical and production parameters to determine 

what is needed 

• Visualize creative ways of enhancing the image. 

• Compile and merge all the layers and enhancements together and ensure that the final 

work-product meets requirements and is in sync with the creative and quality standards of 

the production. 

• Ensure continuity in the final output. 

• Identify the people responsible for health and safety in the workplace, including those to 

contact in case of an emergency. 

• Identify security signals e.g. fire alarms and places such as staircases, fire warden stations, 

first aid and medical rooms. 

• Ensure own personal health and safety, and that of others in the workplace though 

precautionary measures 
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1.2.3 Opportunities for Compositor 
Compositing artists work with lighting directors and FX artists to help create the final finished 

product. There are various opportunities for compositor in the field of production houses and game 

developments. Job growth in the animation industry is expected to average six percent for the 2012-

2022 decade and three percent in the entertainment industry. Although growth in the animation 

and entertainment industries will be slower than average for the 2012-2022 decade, the demand for 

talented compositing artists is still high. A compositor has following benefits for career aspect: 

 

• Medium range of salary with low educational investment 

• Opportunities in Movie production houses, news networks, game industry, and animation 

industry 

• Lots of opportunities to grow in the industry. 

 

1.2.4 Key Professional Skills 

This job requires the individual to have a good understanding of the fundamentals and principles of 

computer graphics. The individual must know the fundamentals of depth and should possess good 

drawing and illustration skills. The individual must have a good working knowledge of compositing 

software including Adobe After Effects, Flame 3D Visual Effects (VFX), Motion 5, Nuke etc. 

 

Exercise 

• Who is a compositing artist? 

 

• What are the common industries where compositor finds job? 

 

 

 

• Discuss the job responsibilities of compositor. 
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•  What is the job of a compositor and what are the opportunities? 

 

 

 

Notes 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 
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Unit 2.1 – Post-Production Processes 

Unit 2.2 – Planning Post-production process 
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Key Learning Outcomes 

At the end of this module, you will be able to: 

1. Attain the creative and technical requirements and expectations in terms of quality of 

deliverables and timelines, as necessary to the role. 

2. Determine key post-production processes like computer-generated effects, color grading, 

digital intermediate, screen conversion, rendering, rotoscopy, keying, match-moving and 

compositing. 

3. Translate expectations into effort estimates for each process. 

4. Prepare a work plan for oneself or other team members based on the production budget, 

timelines and technical viability. 
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UNIT 2.1: Post-Production Processes 

 

Unit Objectives 

At the end of this unit, you will be able to:  

1. Attain the creative and technical requirements and expectations in terms of quality of 

deliverables and timelines, as necessary to the role. 

2. Determine key post-production processes like computer-generated effects, color grading, 

digital intermediate, screen conversion, rendering, rotoscopy, keying, match-moving and 

compositing. 

3. Translate expectations into effort estimates for each process. 

4. Prepare a work plan for oneself or other team members based on the production budget, 

timelines and technical viability. 

 

2.1.1 Post-Production Processes 

Post Production process is the last step of movie/animation production process. Before post-

production process, you go through pre-production and production process. In pre-production 

process, you decide the theme and basic parameters of your product. In production process, the 

raw footage is created based on pre-production data. In post-production process, the raw footage is 

edited and modified to get the desired results. Some of the processes involved in post-production 

are: 

• Computer Generated Effects (CG Effects) 

• Color Grading 

• Digital Intermediate 

• Screen Conversion 

• Rendering 

• Lighting 

• Animating 

• Rigging 

• Rotoscopy 

• Keying 

• Match Moving 

• Composting  

Short descriptions of these processes are given next. 
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2.1.1.1 CG Effects 
CG Effects (Computer Generated Effects) are the scenes or modification of recorded clips to 

enhance the intent of scene. A CG Imagery (CGI) is the final result of all the processes applied on a 

scene for post-production. VFX is a part of CG Effects. 

  

Figure 2.1.1 Computer Graphics Effect 

2.1.1.2 Color Grading 

Color grading is the process making a selected image or scene better presentable in terms of colors. 

In color grading, we control color, contrast, saturation, black level, sharpness, and white point for 

motion pictures, videos, or still images. 
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Figure 2.1.2 Color Grading 

2.1.1.3 Digital Intermediate 

Digital Intermediate (DI) is the final process of making the video ready for production. In this 

process, an edited film is taken in the form of an EDL or a cut list. The film is scanned for the OK 

shots at a very high resolution by working on the shots one at a time, fixing the colors to make the 

film look interesting, maybe doing effects and blending CG with "normal" footage. Finally a negative 

is produced from which the producer can make multiple prints to show in theatres. This negative 

that comes out is an "intermediate" and since it is done digitally, so the process is called "digital 

intermediate". 

 

Figure 2.1.3 Preparing Digital Intermediate 
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2.1.1.4 Screen Conversion or Stereo Conversion 
Screen conversion or stereo conversion is the process of converting the 2D scene into a 3D scene. In 

this process, separate images are created for each eye and then collaborated to give the feel of 

depth while viewing the scene. This process is very costly due to high skills and time required for 

conversion. 

 

Figure 2.1.4 Screen Conversion 

 

2.1.1.5 Rendering 

Rendering is the process of adding shade, color, and texture to a 2-D or 3-D wireframe in order to 

create life-like images on a screen. Rendering performed for movies and animations are called Pre-

rendering and renderings created for games are called Real-time rendering. 
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Figure 2.1.5 Rendering of 3D computerized model 

2.1.1.6 Lighting 
In Lighting process, the artist enhanced each scene of the clip to look more realistic in terms of light. 

Lighting should match the mood of scene and atmosphere.  

 

Figure 2.1.6 Lighting 

2.1.1.7 Animating 

Computer animation is the process of moving 2D or 3D objects in a 3D environment to create 

motion pictures. Using the manipulation of objects (3D models) within the 3D software, we export 

picture sequences which will give the illusion of movement (animation) based on how we 

manipulate the objects. The process of animation is shown in next figure. 
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Figure 2.1.7 Animation process 

 

 

Figure 2.1.8 Animating model 

2.1.1.8 Rigging 

Rigging is the process of making skeleton of the model so that you can deform and move your 

model. In rigging process, you add bones to model and then apply different type of joints to 

represent realistic movement in the model. 
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Figure 2.1.9 Rigging in a model 

2.1.1.9 Rotoscopy 

Rotoscopy is the process of motion of character in motion picture frame by frame. Prior to 

computers, rotoscope was used to perform tracing of action frames. In modern computer system, 

we use software to do the same job. These traced portions of action frame are later replaced by 

desired character or object. 

 

Figure 2.1.10 Rotoscopy 

2.1.1.10 Keying 

In modern software, there is a tool called Key like in After Effects. Using this tool, one can make blue 

or green screen as transparent. The process of making the background of an image transparent and 

then replacing it with desired one is called keying. 
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Figure 2.1.11 Keying 

2.1.1.11 Match Moving 
Match moving is used to track the movement of camera in a shot and replace it with identical virtual 

movement created in 3D animation software.   

 

Figure 2.1.12 Match Moving 
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2.1.1.12 Compositing 
Compositing is the combining of visual elements from separate sources into single images to create 

the illusion that all those elements are parts of the same scene.  

 

Figure 2.1.13 Compositing 
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Notes 
__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 
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UNIT 2.2: Post-Production Processes Planning and Cost 

Estimation 

 

Unit Objectives 

At the end of this unit, you will be able to:  

1. Achieve the creative and technical requirements and expectations in terms of quality of 

deliverables and timelines, as necessary to the role. 

2. Translate expectations into effort estimates for each process. 

3. Prepare a work plan for oneself or other team members based on the production budget, 

timelines and technical viability. 

 
 

2.2.1 Post-Production Processes Planning 

There are various factors involved in planning of post-production processes. Some of the most 

influential factors are discussed next. 

• Customer Requirement 

• Tools and Equipment required for process 

• Cost of process 

• Technical skills required for the process 

• Time taken by the process 

Based on these factors, the production manager decides which process to be used in post-

production. These factors are discussed next. 

 

2.2.1.1 Customer Requirement 

Customer requirement is the most important and influential factor. Most of the time customer is a 

production manager or movie director. He/She decides when to use vfx, animation, match moving 

or any other effect. 

 

2.2.1.2 Tools and Equipment required for process 

There are various tools and equipment used by animators that cost almost equal to cost of small 

production movies.  Some of the cameras like Imax, Phantom Flex cost so much that they are only 

available as rental items. 
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2.2.1.3 Cost of Process 
Cost of a post-production process is also important factor for budget movies. Cost of VFX in movies 

like The Amazing Spider Man 2, Man In Black 3 was about $65 million (approx. 460 crore Rupee). So 

the person responsible for inclusion of VFX needs to consider the cost before deciding the post-

production processes. 

2.2.1.4 Technical Skills Required 

Some of the post-production processes need high technical skills in the artist. Jobs like Scientific 

Visualization Developer, Character Rigger and so on need very competitive skills in the artist. Some 

jobs even need degree in science and math. While selecting the post production process, one needs 

to consider if the respective artists are available in the vicinity or not. 

2.2.1.5 Time Taken by Process 

Some of the processes like Rotoscopy, 3D Modeling, Match Moving take most of the time in VFX. 

Sometimes rotoscopy of a 3 second clip can take almost 20 hours. Various processes involved in VFX 

are given next. 

• Concept art 

• Storyboard / Pre Production 

• 3D Cinematic / Animatic / Pre-visualization 

• Sculpting of main characters and props (if required) 

• 3D Modeling, UV unwrapping, Texturing 

• Rigging, Animation 

• FX / Simulation 

• Shading, Lighting 

• Render passes 

• Live action shooting 

• Rotoscopy, Chroma removal, Tracking, Match moving, Wire removal, Paint (Prep), Matte 

painting 

• Projection mapping, Relighting 

• Compositing of all elements 
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2.2.2 Cost Estimation 
Cost of movie production and profit made by movie are the main factors that concern the producer 

of every movie. Budget creation of movie can be divided into four phases Above-the-line, Shooting 

Period, Post-Production, and Miscellaneous. In Above-the-Line section, write down the cost of script 

preparation, script rights securing, salaries and living expenses of staff. In Shooting section, note 

down the cost of shooting equipment, local rentals, transportation, film cost, camera cost, and 

production crew salary. In Post-Production section, note down the cost associated with finishing of 

movie like cost of VFX and screening cost. In the Miscellaneous section, note down the cost 

associated with  packaging the film, shipping it to theaters, attending film festivals or Internet 

streaming costs and showing the film. An example of cost break-up of a high-end movie is given 

next. 

• Concept and Story Boarding : ₹50,000 to ₹2,00,000 

• Project Management Cost : ₹1,00,000 to ₹3,00,000 

• Film Crew Cost   : ₹4,25,000 to ₹12,50,000 

• Direction Cost   : ₹35,000 to ₹2,70,000 

• Studio Rent   : ₹30,000 to ₹2,00,000 

• Special Equipment  : ₹40,000 to ₹2,00,000 

• Teleprompter   : ₹12,000 - ₹27,000 

• Talent    : ₹60,000 - ₹60,00,000 

• Talent Shooting Days  : 3 days 

• Hair & Make-up   : ₹20,000 - ₹70,000 

• Location costs   : ₹50,000 - ₹2,00,000 

• Extras    : ₹20,000 - ₹1,00,000 

• Craft Services   : ₹20,000 - ₹70,000 

• Props and staging  : ₹40,000 - ₹2,00,000 

• Transportation   : ₹35,000 - ₹1,00,000 

• Editing    : ₹1,20,000 - ₹5,00,000 

• Animation & Special Effects : ₹1,20,000 - ₹6,00,000 

• Music    : ₹1,00,000 - ₹1,00,00,000 

• Voice-Over   : ₹20,000 - ₹10,00,000 

• Audio and Foley   : ₹50,000 - ₹2,00,000 

• Stock Images and Footage : ₹10,000 - ₹2,00,000 
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Exercise  
1. Write a note on history of camera development. 

 

 

 

 

 

  

2. How does an analog film camera works ? 

 

 

 

 

 

3. What are the factors that affect video quality? 

 

 

 

 

 

4. Why do we use green or blue color only in the vfx? 
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5. Discuss the steps for transporting camera from rental store. 

 

 

 

 

 

6. Discuss the basic steps of assembling battery and card in camera. 
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Key Learning Outcomes 

At the end of this module, you will be able to: 

1. Gather raw footage/material and select, or assist in selecting, relevant material that can be 
used for post-production. 

2. Ingest, or support in ingesting, the footage and keep the material ready for the post-
production process. 

3. Create back-ups for interim work-products saved in the appropriate file formats, and take 
responsibility/manage others’ interim work-products as relevant to the role. 

4. Supervise others in ensuring, that final work-products are prepared in appropriate file 
formats (such as mp4, avi, wmv, mpg and mov), appropriate mediums (such as DVD, film, 
tape and digital), and are compatible with intended distribution/exhibition mediums. 

5. Clear logs/data and keep the software and equipment ready for future use. 
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UNIT 3.1: Tools and Equipment for Compositing 

 

Unit Objectives 

At the end of this unit, you will be able to:  

1. Use tools and equipment for compositing like computer system, software, data transfer 
devices, . 

2. Create back-ups for interim work-products saved in the appropriate file formats, and take 
responsibility/manage others’ interim work-products as relevant to the role. 

3. Supervise others in ensuring, that final work-products are prepared in appropriate file 
formats (such as mp4, avi, wmv, mpg and mov), appropriate mediums (such as DVD, film, 
tape and digital), and are compatible with intended distribution/exhibition mediums. 

4. Clear logs/data and keep the software and equipment ready for future use. 
 

 

3.1.1 Tools and Equipment 

The work performed by a compositor is mainly digital. So, there are not too many hardware tools 

needed by a compositor. A compositor must have a computer system with good configuration. A 

common system configuration required by compositor these days is given next. 

• Processor : i7 (8th or 9th generation) or AMD Ryzen 7 

• RAM  : 16 GB to 32 GB 

• Graphic Card : Nvidia GTX 1050 for entry and GTX 1080 for high-end 

• Storage  : SSD of 250 GB minimum for software and Operating system and                    
Hard Disk of minimum 1 TB 

• Motherboard : Compatible for your CPU, RAM, GPU and Storage media 

• One additional screen for simultaneous editing and video preview with minimum 4k 

resolution 

 

3.1.1.1 Software 

Apart from hardware tools, a compositor needs an array of software for doing their work. There are 

mainly two categories of compositing software.  

• Layer Based Compositing  

• Node Based Compositing 

In Layer based compositing software, all the clips/images are stacked one over the other in the form 

of layers. 
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In Node based compositing software, node works as modifier for the video. When you pass the 

video through a node which can change the color, resolution etc. of the  video then at output you 

can see the effect and at input you can check the raw video. In this way, you have full control of 

output with live preview. In node based software, you get node graph where you can check the 

effects of different node operations. 

 

Figure 3.1.1 Node graph 

Both the software types are capable of compositing operation but selection depends on the 

complexity of operation. If you need a few effects in your video then a layer based software is better 

due to faster solution. When you need multiple passes to create a perfect finish then it is better to 

use node based software. 

Some of the commonly used software are discussed next. 

Adobe After Effects 

Adobe After Effects is the most famous layer based compositing software.  It is a digital visual 

effects, motion graphics and compositing software by Adobe Systems. There are many third party 

plug-ins available for After Effects that can apply realist effects of rain, fire, snow etc. in your video. 
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Figure 3.1.2 Adobe After Effects Interface 

Blender 

Blender is a free and open-source 3D content creation suite available for all major operating systems 

under the GNU General Public License. It may not have all the features of leading packages such as 

Max and Maya but this software is a great value considering it costs nothing. Everyone can take 

advantage of Blender’s tools for modeling, animation, rigging, rendering, shading, UV unwrapping, 

physics and particles, imaging and compositing, and real time 3D/game creation. It is a node based 

compositing software. Blender can be downloaded from www.blender.org where visitors will find 

educational materials, support as well as an online community of users. 

 

Figure 3.1.3 Blender Interface 
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Nuke 

Nuke is a node based digital compositing software developed by The Foundry Visionmongers 

company. This is one of the most popular software used by compositors. The software is available 

on multiple platforms like Windows, Linux, Apple OS etc. 

 

Figure 3.1.4 Nuke Interface 

 

Natron 

Natron is an open source powerful compositing software that can handle 2D and 2.5D compositing 

operations. Natron has powerful rotoscopy, keying and tracker tools. This software is free to use for 

everyone. 

 

Figure 3.1.5 Natron Interface 
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Fusion 

Fusion earlier known by the name Eyeon Fusion has recently been acquired by Blackmagic. The 

latest version of software Fusion 9 is available free to use. For studios, company offer a premium 

version of software with the name Fusion 9 Studio. Fusion is also a node based compositing 

software. 

 

Figure 3.1.6 Eyeon Fusion Interface 

 

Autodesk Flame 

Autodesk Flame is a node based compositing software used by many vfx artists in creating 

Hollywood movies. Flame provides tools for visual effects, 3D compositing, and editorial finishing. 

 

Figure 3.1.7 Flame Interface 
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There can be many other software generic or specialized for the studio requirement. 

Other that software and computer hardware there are various other tools required by compositor. 

These tools are discussed next. 

3.1.1.2 Data Transfer Media 

There are various data transfer tools used by compositor to transfer video from source to their 

computer system and from their computer system to production agency. These tools are as follows: 

Pen Drive or USB Flash Drive 

A pen drive is also know by the names thumb drive, flash drive, gig stick, jump drive, disk key, and so 

on. Most of the pen drive core weight less than 30 gram. These days you can easily find pen drive of 

storage capacity 2 GB to 1 TB. 

 

Figure 3.1.8 Pen drive 

Backup Drive or Portable Hard Drive 

Backup Drive, also called portable hard drive is used to transfer large amount of data. 

 

Figure 3.1.9 Backup Drive 
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CDs, DVDs, and Blu-ray discs 

CD (Compact Discs) and DVD (Digital Versatile Discs) are used to permanently store data in optical 

record. A CD can store data of 700 MB, a single sided DVD can store 4.7 GB data and a double sided 

DVD can store data up to 9.4 GB. A dual layer double sided DVD can store up to 17 GB data. A single 

layer blu-ray disc has a capacity of 25GB and dual layer blu-ray disc has capacity of 50 GB data 

storage. 

 

Figure 3.1.10 Disc types 
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Notes 
__________________________________________________________________________________ 
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__________________________________________________________________________________ 

__________________________________________________________________________________ 
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__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 
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UNIT 3.2: Preparing Data for Compositing 

 
Unit Objectives 
At the end of this unit, you will be able to:  

1. Gather raw footage/material and select, or assist in selecting, relevant material that can be 
used for post-production. 

2. Ingest, or support in ingesting, the footage and keep the material ready for the post-
production process. 

3. Prepare back-ups for interim work-products are saved in the appropriate file formats, and 
take responsibility/manage others’ interim work-products as relevant to the role. 

4. Apply different effects on video using Adobe After Effects. 
 

 

3.2.1 Gathering Data for Composition 

A compositor’s job is to combine different videos and images to get the desired clip but the 

important part is what type of videos or images can be combined so that compositor gets the 

desired results. More precisely, what factors influence the composition of different videos/images. 

Following is the list of factors that should match properly while making composition. 

VFX Lighting Cues 

• Location/direction 

• Quantity—intensity 

• Color 

• Quality—hardness/softness 

• Movement 

• Distribution (throw) 

Finished Lighting 

• Black (shadow), white (highlight), gray (gamma) density match 

• Brightness and contrast match 

• Color match 

• Light direction match 

• Light quantity/intensity 

• Light quality match 

• Interactive lighting 

• Shadow match 

• Atmospheric haze 
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VFX Camera Cues 

• Format 

• Aspect ratio 

• Height 

• Angle 

• Focus 

• Movement 

• Motion blur 

• Film stock/video source (grain/noise) 

Finished Camera Lens Matching 

• Focus 

• Depth of field 

• Lens flare 

• Light fog glare 

• Lens distortion 

Screen Aspect Ratio 

• Standard PC (4:3) 

• Standard PC—Vertical (3:4) 

• Photo (36:24) 

• Square (1:1) 

• 16mm (18:13) 

• IMAX (10:7) 

• Television HDTV (16:9) 

• 70mm (46:21) 

• Panavision (47:20) 

• Cinemascope (8:3) 

• 65mm (11:4) 

• UltraPanavision 70mm (69:25) 

• U.S. Letter (279:216) 

• A4 (297:210) 
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Figure 3.2.1 Screen Aspect Ratio 

3D Object Inspection 

• What is the object? 

• What are the base colors? 

• How was the object made? 

• What is the object made of? 

• Where was the object made? 

• When was the object made? 

• Who made the object? 

• What is the object’s history? 

• How was the object used? 

• What kind of wear would this use cause to this object? 

• How has the weather affected it? 

• What does it feel like? 

• How does light affect the object? 

• How has the environment affected the object? 

• What kind of damage and dirt buildup should the object show and where? 

Photography for 3D Textures 

• Even lighting, no harsh directional shadows (overcast days) 

• Orthographic (step far back and zoom in to reduce parallax distortion) 
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• Resolution (highest possible)  

On-Set VFX Camera Data and Scene Reference 

• Camera make and model 

• Film back, CCD, or CMOS sensor size 

• Camera mount 

• Film stock or video acquisition format 

• Lens information (make, model, focal length, zoom, and so on) 

• Aperture/F-stop 

• Shutter speed 

• Depth of field 

• Camera height 

• Camera distance to subject/focal distance 

• Camera angle or tilt 

• Camera settings (iris, filters, zoom, and so on) 

• After shoot (shoot reference and registration photos using a reference object of known 

dimensions, camera lens distortion correction grid, lighting reference/probes, and take set 

and prop measurements) 

Most of the factors are not in direct control of a compositor. In few cases, compositor has to as for a 

new shot but most of the time, a compositor can edit the footage using software to get desired 

results. In this book, we are going to use two software to perform compositing which are Adobe 

After Effects and Nuke.  

3.2.2 Preparing Videos for Composition 

Most of the time video preparation will need color correction, resizing, distortion, noising, and text 

addition. We will discuss these modifications using Adobe After Effects. 

3.2.2.1 Opening Video File in After Effects 

• Start Adobe After Effects by clicking on the shortcut from Start Menu. The interface of 

Adobe After Effects will be displayed. 
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Figure 3.2. 2 Adobe After Effects interface 

• Click on the Import->File option from the File menu in the Menu bar. The Import File dialog 

box will be displayed. 

 

Figure 3.2. 3 Importing file option 
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Figure 3.2. 4 Import File dialog box 

•  Double-click on the file that you want to import for editing. The imported file will be added 

in the Project panel of the software. 

 

Figure 3.2. 5 Loading video file 

• Drag the file from Project panel to timeline. 
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Figure 3.2. 6 Loading video in project 

3.2.2.2 Color Correction 

In previous step, we have imported a file on which we are going to perform color correction and 

other editing steps. 

• Click on the video in timeline once to activate the tools in Effects menu. 

• Click on the Color Correction cascading menu in the Effects menu to check the tools 

available for color correction. 

 

Figure 3.2. 7 Color Correction 

There are various tools available in Color Correction cascading menu to correct color of the video or 

image. Some the important color correction operations are discussed next. 

 



 

 
 
 

Housekeeping Attendant (Manual Cleaning) 

49 

Compositor 

Auto Color, Contrast or Levels 

The three Auto tools in Color Correction cascading menu are used to automatically set the color, 

contrast and difference between highs and lows of color based on the shadows, mid tones and 

highlights of the video frames/image. 

• Click on the Auto Color to adjust the color automatically. 

• Click on the Auto Contrast to adjust the contrast automatically. 

• Click on the Auto Level to adjust the difference between highs and lows of color 

automatically. 

 

 

Figure 3.2. 8 Auto Corrections applied 

Black & White Effect 

Using this effect, you can make the image black and white from colored. To use this effect, click on 

Black & White option from the Color Correction cascading menu of the Effects menu in the menu 

bar. The effect will be added in the project and you can modify the parameters from the Effects 

Control panel. 
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Figure 3.2. 9 Applying Black & White effect 

Note that if you want to remove any effect then click once on fx button for respective effect in the 

Effects Control panel. 

Adjusting Brightness and Contrast 

The Brightness and Contrast tool in Color Correction cascading menu of the Effects menu is used to 

adjust brightness and contrast of the video. After selecting the tool, hover the cursor over the value 

of brightness or contrast and drag to change the value. To manually enter the value, double-click on 

it. 

 

Figure 3.2. 10 Adjusting brightness and contrast 

Change Color 

The Change Color tool in Effects cascading menu is used to change the selected color in the 

image/video. After selecting this tool, click on the box of Color to Change field and select the color 

to be changed. Set the other parameters as desired in the Control panel. 
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Figure 3.2. 11 Changing color 

Change to Color 

The Change to Color tool is used to change selected color to a desired color. Select this tool from the 

Color Correction cascading menu. The options will be displayed as shown below. Set the desired 

parameters to change color. 

 

Figure 3.2. 12 Replacing color 

Similarly, you can use the other tools in the Color Correction cascading menu like color balance, 

color stabilizer, exposure, and so on. 

3.2.2.3 Resizing 

The tools to resize are available in the Transform cascading menu of the Layer menu in the Menu 

bar. 
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Figure 3.2. 13 Transformation tools 

• Click on the Scale tool from the Transform cascading menu. The Scale dialog box will be 

displayed. Set the desired parameters in the dialog box and click on the OK button. 

 

Figure 3.2. 14 Scale dialog box 

Similarly, you can use the other tools in the cascading menu like rotation, position, flip and so on. 
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3.2.2.4 Distortion 
There are various tools available in the Distort cascading menu to modify the shape of image/video 

clip.  

  

Figure 3.2. 15 Distort option 

We will discuss the Bezier Warp tool here. You use the other tools in the same way. 

Bezier Warp 

• Click on the Bezier Warp tool from the Distortion cascading menu of the Effect menu in the 

Menu bar.  

 

Figure 3.2. 16 Applying Bezier warp 

• Drag the handles to modify the shape of image/video or specify the desired values in the 

Effects control panel. 



 
 

    
 
 

Participant Handbook 

54 

3.2.2.5 Adding Grains and Noise 
The tools to add grain and noise are available in the Noise & Grain cascading menu of the Effect 

menu in the Menu bar. 

 

Figure 3.2. 17 Noise and Grain options 

The procedure to add grains and noise is discussed next. You can apply the same procedure for 

other tools. 

Adding Grain 

• Click on the Add Grain tool from the Noise & Grain cascading menu of the Effect menu. The 

Add Grain effect will be added in the Effects Control panel and you will be asked to specify 

placement of grain window. 

 

Figure 3.2. 18 Adding grains 
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• Expand the Preview Region node and set the size of preview window as desired. You can 

select the Final Output option from the Viewing Mode drop-down in the control panel to 

check the result of applied grains. 

• Set the other parameters as desired to create grains; refer to next figure. 

 

Figure 3.2. 19 Setting grain parameters 

Adding Noise 

Noise tool in Noise & Grain cascading menu of Effects menu is used to add noise in the video/image. 

 

Figure 3.2. 20 Adding noise 
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Exercise  
1. Discuss the conceptual tools of cinematography. 

  

 

 

 

 

  

2. Discuss the overlapping or triple-take method of shooting. 

 

 

 

 

 

3. What are the basic moves of camera? 

 

 

 

 

 

4. Discuss the moving shots. 
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5. What is the difference between reflection and refraction of light? 

 

 

 

 

 

 

 

6. Write a note on depth of field and focus setting. 

 

 

 

 

7. Write a note on focus measurement and tools used for focus measurement. 

 

 

 

 

8. What is the effect of F/Stop on focus? 
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Unit 4.1 – Fundamentals of Compositing 

Unit 4.2 – Performing Compositing  

 

MES/N3507 



 
 

    
 
 

Participant Handbook 

60 

 

Key Learning Outcomes 

At the end of this module, you will be able to: 

1. Analyze briefs, scripts, visual references, technical and production parameters to determine 

what is needed. 

2. Gather the raw material/layers that need to be put together in the final output, which could 

include characters, layouts, props/objects, effects and layers. 

3. Visualize creative ways of enhancing the image (including lighting, shadows, colors, textures, 

shading, exposure and additional layers). 

4. Compile and merge all the layers and enhancements together and ensure that the final 

work-product meets requirements and is in sync with the creative and quality standards of 

the production. 

5. Manage continuity in the final output. 
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UNIT 4.1: Fundamentals of Compositing 

 

Unit Objectives 

At the end of this unit, you will be able to:  

1. Analyze briefs, scripts, visual references, technical and production parameters to determine 

what is needed. 

2. Gather the raw material/layers that need to be put together in the final output, which could 

include characters, layouts, props/objects, effects and layers. 

3. Perform different types of key matte like luma key, chroma key, difference matte, bump 

matte and so on. 

4. Perform matte refinement with different methods.  

5. Compile and merge all the layers and enhancements together and ensure that the final 

work-product meets requirements and is in sync with the creative and quality standards of 

the production. 

6. Apply the basics of compositing in production. 

 

4.1.1 Fundamentals of Compositing 

The ultimate artistic objective of a digital composite is to take images from a variety of different 

sources and combine them in such a way that they appear to have been shot at the same time, 

under the same lighting conditions, with the same camera. To do all of this well, it is important to 

have a substantial understanding of the technology, because many of the obstacles that you will 

encounter are, in fact, not artistic obstacles. They stem from underlying technical issues that are not 

at all obvious to the casual observer but create problems in the shot. 

It takes three distinct bodies of knowledge to be a good digital effects artist: the art, the tools, and 

technique. The artistic knowledge is what allows you to know what it should look like in the first 

place in order to achieve photo-realism. The knowledge of your tools is simply knowing how to 

operate your particular compositing software package. The third body of knowledge, which is 

technique, comes with experience. Eventually, you become a seasoned veteran, to the point where 

you are seeing most problems for the second or third time and you know exactly what to do about 

them. The beginner, however, is continually confronting problems for the first time and it takes time 

to run through all the bad solutions to get to the good ones. 

Compositing is mainly used for 2D content. Augmented reality (AR) uses compositing techniques for 

displaying layers of images at different depth levels.  

In compositing, the first step is to prepare matte. A very important point to keep in mind is that 

pulling a matte from an image, even a perfectly shot bluescreen, is in fact a clever cheat – it is not 

mathematically valid. It could be characterized as a fundamentally flawed process that merely 
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appears to work fairly well under most circumstances, so we should not be surprised when things go 

badly – which they do frequently. Different types of Matte are discussed next. 

4.1.1.1 Luma Key Matte 

Luma-key mattes get their name from the world of video, where the video signal is naturally 

separated into luminance and chrominance. The luminance (brightness) part of the video is 

commonly used to create a matte (or “key,” in video-speak) in order to isolate some item for special 

treatment. 

A luma-keyer takes in an RGB image and computes a luminance version of it, which is a 

monochrome (one-channel grayscale) image. A threshold value is set, and all pixel values greater 

than or equal to the threshold are set to 100% white and all pixel values less than the threshold are 

set to black. 

  

Figure 4.1.1 Luma Key  

4.1.1.2 Chroma Key Matte 

Chroma-key mattes also get their name from video work, where again, the video signal is naturally 

separated into luminance and chrominance. The chrominance (color) part of the video is used to 

create a matte (key) in order to isolate some item for special treatment. 

The chroma-keyer node takes in the RGB image and converts it to an HSV (Hue, Saturation, Value or, 

if you prefer, color, saturation, brightness) or HSL type of representation internally. The reason that 

the original RGB version is not used internally is because the keyer needs to distinguish between, 

say, levels of saturation, which is not an RGB attribute, but is an HSV attribute. A starting RGB value 

is set which represents the “center” of the chroma key matte, then additional tolerances are set that 

permit the addition of saturation and value (brightness) ranges to be included in the matte. A good 

chroma-keyer will also permit some sort of “tolerance” settings to allow for a graceful transition 

with soft edges. 

The chroma key is very flexible for two important reasons. First, it allows you to go after any 

arbitrary color. It does not have to be a carefully controlled bluescreen, for example. Second, it 

accommodates the natural variations in the color of real surfaces by having saturation and value 



 

 
 
 

Housekeeping Attendant (Manual Cleaning) 

63 

Compositor 

ranges to expand its window of acceptance. If you examine the color of skin, for example, you will 

find that the shadow regions not only get darker, but also have lower saturation. To pull a matte on 

skin, therefore, you need something that will not only select the RGB color you picked for the main 

skin tone, but also follow it down into the shadows with lower saturation and value. 

 

Figure 4.1.2 Chroma Key Matte 

4.1.1.3 Difference Matte 
The difference matte works by detecting the difference between two plates: one plate with the item 

of interest (the “target”) to be isolated, and the other a clean plate without the item of interest. For 

example, a scene with the actor in it, and the same scene without the actor. This obviously requires 

the scene to be shot twice with either a locked off camera or, if the camera is moving, two passes 

with a motion control camera. 

   

Figure 4.1.3 Difference Matte 

4.1.1.4 Bump Matte 

The bump matte will give you a matte of just the bumps even when they are on an uneven surface. 

Because of the uneven brightness, many of the bump tips are darker than the brighter regions of the 

surface. You need a method that just lifts out the bumps, regardless of their absolute brightness. 

The bump matte is based on the local brightness of the region immediately surrounding each bump, 

so it continuously adapts to the local brightness everywhere in the picture. The idea is to make a 

luminance version of the target plate that makes the bumps stand out as much as possible. A 

blurred version of the target plate is then generated, and this blurred version is subtracted from the 

luminance version. Wherever the bumps stick up above the blurred plate, you will get a matte point. 
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This is an entirely different result from performing an edge detect. The edge detection would 

actually draw circles around all the bumps, while the bump matte actually gets the bumps 

themselves. 

   

Figure 4.1.4 Bump Matte 

4.1.1.5 Color Difference Matte 

The color difference matte (not to be confused with the plain “difference matte”) is one of the best 

matte extraction methods for bluescreens, because of its superior edge quality and reasonable 

semi-transparency characteristics. Though originally conceived for bluescreen matte extraction, the 

color difference matte technique can often be used to pull a matte on an arbitrary object that has a 

single dominant color, such as a red shirt or a blue sky, for example. The importance of this section 

is twofold. First, by understanding the color difference matte process, you will be able to “assist” 

your favorite keyer when it’s having trouble. Second, if you cannot use a keyer, either because your 

software doesn’t have one or it’s having problems with a bluescreen plate, you can always make 

your own color difference matte. 

  

Figure 4.1.5 Color Difference Matte 

4.1.1.6 Adobe After Effects Matte 

Adobe has developed a rather different method of generating a raw matte that is very simple and, 

frankly, works much better than it should. It only uses the blue and red channels; the classical 

method uses all three. For a bluescreen, the blue channel is inverted, and then the blacks are scaled 
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down to zero. This result is then screened with the red channel to create the raw matte, which is 

then scaled to make a solid white core and zero black backing. 

   

   

Figure 4.1.5 Adobe After Effects Matte 

4.1.2 Matte Refinement 

Regardless of the method used to pull a matte, there are a variety of operations that can be applied 

to refine the quality of any matte like reduce grain noise, soften the edges, and expand or contract 

the matte size to get a better composite. One of the first preprocessing operations to be done on 

virtually any bluescreen matte extraction process is to garbage-matte the backing color. The basic 

idea is to replace the backing area all the way out to the edges of the frame with a clean, uniform 

color so that when the matte is extracted, the backing region will be clean and solid all the way out 

to the edges of the frame. There are two important criteria to this operation. First, that it replaces 

the bluescreen a safe distance away from the edges of the foreground object. You must make sure 

that it is the matte extraction process that takes care of the foreground object edges, not the 

garbage matte. The second criteria is that it not take too much time. 

 

Figure 4.1. 6 Matte Refinement 
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Following are some of the operations performed on the matte for refinement. 

• Noise Suppression 

• Softer Edges 

• Controlling the Blur Operation 

• Adjusting the Matte Size 

4.1.3 Despill 

When an object is filmed in front of a green screen, green light from the brightly lit green backing 

screen contaminates the foreground object in a variety of ways. The edges of the foreground object 

are not perfectly sharp due to lens limitations, so the edges become blended with the green 

backing. There may also be semi-transparent elements, such as smoke or glass, and the ever-present 

wisps of hair. There can be shiny elements that reflect the green backing, regardless of how much 

dulling spray is used. Then there is the ubiquitous flare and spill. 

Flare is seen as a green “haze” that covers everything in the frame, including the foreground object 

that you are trying to isolate from the green backing. It is caused by the flood of green light entering 

the camera and bouncing around inside, lightly exposing the negative all over to green. The second 

contamination is spill. This stems from the fact that the green backing is in fact emitting a great deal 

of green light, some of which shines directly on areas of the foreground object that are visible to the 

camera.  

In broad strokes, the despill operation simply removes the excess green from the green screen plate 

based on some rule, of which there are many to choose from. The despilled version of the green 

screen is then used as the foreground layer of the composite. 

 

4.1.4 Compositing 

The compositing operation is the fundamental image combining operation of, well, digital 

compositing. The process is essentially the same, even when done optically – there is a foreground 

layer, a background layer, a matte to identify which region is which, and the final composited 

results. In addition to defining where the foreground and background appears in the frame, the 

matte also controls the degree of foreground transparency. The key elements of a basic composite 

are shown in figure next. 
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Figure 4.1.7 Compositing 

You will learn about various compositing techniques in next unit. 
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UNIT 4.2: Performing Compositing 

 

Unit Objectives 

At the end of this unit, you will be able to:  

1. Operate basic functions in Nuke. 

2. Apply the workflow of compositing in Nuke. 

3. Gather the raw material/layers that need to be put together in the final output and import 

them in Nuke software. 

4. Visualize creative ways of enhancing the image (including lighting, shadows, colors, textures, 

shading, exposure and additional layers). 

5. Compile and merge all the layers and enhancements together and ensure that the final 

work-product meets requirements and is in sync with the creative and quality standards of 

the production. 

6. Manage continuity in the final output and perform rendering. 

7. Create animation of compositing to generate a video. 

 

4.2.1 Performing Compositing with Nuke 

Nuke uses node-based workflow where you need to connect nodes to read, process, and manipulate 

images for compositing. 

 

Figure 4.2.1 Workflow of Nuke  

Saved projects are called script files. 
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Figure 4.2.2 Nuke Script 

4.2.1.1 Nuke Windows and Interface 

 

Figure 4.2.3 Nuke Windows 

Onto these panes, you can add the following panels: 

• Toolbars for selecting nodes 

• Node Graphs (also known as DAGs) for building node trees 

• Curve Editors for editing animation curves 

• Properties Bins for adjusting the nodes’ controls 

• Viewers for previewing the output 

• Script Editors for executing Python commands. 
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Figure 4.2.4 Main window with a Node Graph, Viewer, and Properties Bin 

 

Figure 4.2.5 Menu and Toolbar 

   

Figure 4.2.6 Content Menus   Figure 4.2.7 Right-click menu 
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Menu Functions 

 

Table 1 Menu options 

Nodes in Nuke 

Nodes are the building blocks of the process tree. Everything that happens to an image in Nuke 

happens by using nodes. 

 

Figure 4.2.8 Node 

A node is usually represented by a rectangular shape with the name of the node in the middle. 

There’s usually an input (or more than one) at the top of the node, and a single output at the 

bottom. on some nodes there is a mask input on the side of the node. To create a node, select the 

desired tool from the Nodes toolbar. The Nodes Toolbar is split into several toolboxes.  

 

Figure 4.2.9 Icons for Nuke nodes 
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Figure 4.2.10 Icons for Nuke nodes 

Nuke File Browser 

The File Browser is used whenever reading or writing images to and from the disk drive. 

 

Figure 4.2.11 File Browser 
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Viewer 

The Viewer is used to view your work as you go, receive feedback when editing nodes, compare 

different images, and manipulate properties on the image. 

 

Figure 4.2.12 Viewer 

Nuke Process Tree 

A process tree is a very intuitive way to change the appearance of images. It is essentially a graphical 

representation of the process the image or images are going through. If you know what process you 

want your images to go through, the process tree will represent the process you are thinking of. 

 

Figure 4.2.13 Process Tree 
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4.2.2 Loading Images in Nuke 

• Launch Nuke. 

• While hovering the mouse pointer over the DAG (the Directed Acyclic Graph, also called the 

Node Graph), press the R key. 

• Navigate to the directory of desired files. 

• Select the first file and click the Next button, then select the second file and click the open 

button or press the Enter/Return key on your keyboard. You now have two new Read nodes 

in the DAG. 

 

Figure 4.2.14 Read Nodes 

• Hover the mouse on desired node and press 1 to check the loaded file. 

4.2.3 Merging Images 

The definition of compositing is combining two or more images into a seamless, single image. 

• Select Read2 and choose Merge from the Merge toolbox. The Merge node can connect two 

or more images together using various layering operations such as overlay, Screen, and 

Multiply. However, the default operation called over simply places a foreground image with 

an alpha channel over a background image. 

 

Figure 4.2.15 Merge Node 
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• Click and drag Merge1’s B input towards Read1 and release it over Read1. 

• Select Merge1 and press 1 on the keyboard to view the result in the Viewer. 

  

Figure 4.2.16 Preview of merging 

• Click Read2 and press 1 on the keyboard to view it in the Viewer. 

• While hovering your mouse pointer over the Viewer, press the A key to view the alpha 

channel. 

 

Figure 4.2.17 Checking alpha channel of doll 

• Press the A key again to switch back to viewing the RGB channels. 

4.2.4 Saving Nuke Script 

Nuke saves its project files, or scripts, as ASCII files. An ASCII file is a text file that you can open in a 

text editor. ASCII files stand in contrast to binary files, which do not make any sense when opened in 

a text editor and are only readable by specific applications. 

• Press Ctrl-S to save the file or choose File > Save. 
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4.2.5 Transforming Image 
The Transform node is a 2D axis that can reposition an image on the X and Y axes and rotate, scale, 

and skew. The Transform node resides in the Transform toolbox in the Nodes Toolbar. It also has a 

hot key assigned to it (T). 

 

Figure 4.2.18 Transforming Image 

4.2.6 Connecting Nodes 

• To connect an unattached node, drag its input pipe to the center of the node to which you 

want to connect. 

• To move a pipe from one node to another, click the end you want to connect (input or 

output) and drag it to the node you want to connect it to. 

• To branch an existing output to an existing node, Shift-click the existing outgoing pipe and 

drag the newly created pipe to the existing node. 

    

Figure 4.2.19 Connecting Nodes 
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4.2.7 Arranging Nodes 
It is also good practice to keep a tree organized. The definition of “organized” is subjective, but the 

general idea is that looking at the tree makes sense, and following the flow from one node to the 

next is easy. Here are a few ways to keep an organized tree: 

• Nodes snap to position when they get close to other nodes both horizontally and vertically. 

• To arrange a few nodes together, select them, and then press L on the keyboard. Use this 

with caution—you can get unexpected results because Nuke uses simple mathematical rules 

instead of common sense. You might expect that the Read nodes would be on top, but 

sometimes they’re on the side. 

• You can also create backdrops around part of your tree that remind you where you did 

certain things—a kind of group, if you will. Access these Backdrop nodes through the other 

toolbox. You will learn this shortly. 

4.2.7 Disabling and deleting nodes 

As you add nodes, you can also disable and delete nodes by using shortcuts. 

• To disable a node, select it and press D on the keyboard. To enable it, repeat. 

• To delete a node, select it and press Backspace/ Delete on the keyboard. 

4.2.8 Changing Properties 
You can change the properties of composition by on-screen controls. Some nodes, such as the 

Transform node, have on-screen controls. When a node is created, its Properties panel is 

automatically loaded into the Properties Bin. The controls that are now on-screen belong to the 

newly created Transform1 node. You can use these controls to change the position, scale, rotation, 

skew, and pivot of the image. 

 

Figure 4.2.20 On-Screen Controls for Nodes 
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4.2.9 Animation Menu 
The Animation button/menu on the right side of any property deals with animation related options. 

Choose options from this menu to create a keyframe, load a curve onto the curve editor, and set the 

value of a property to its default state. The Animation menu controls all values grouped under this 

property. 

 

Figure 4.2.21 Animation menu 

After applying the modifications, the next step is to render. 

4.2.10 Rendering 

To render your tree, you need to use a Write node, which contains several functions. The Write 

node defines which part of the tree to render, where to render to, how to call your file or files, and 

what type of file you want to create. The end of your tree is where you can see the final composite. 

You need to add Write node there. 

• Click Merge1 at the bottom of the tree and press the W key. You can also choose Write from 

the Image toolbox in the Nodes Toolbar or use the Tab key to create a Write node by 

starting to type the word write 



 

 
 
 

Housekeeping Attendant (Manual Cleaning) 

79 

Compositor 

 

Figure 4.2.22 Write node 

• In the Write1 Properties panel, click on the File property line. The File Browser will be 

displayed. 

• Set the desired location for saving the files. 

• In the field at the bottom, at the end of your path, add the name of your file sequence. 

 

Figure 4.2.23 Adding sequence 

• Click Save. Choose LZW from the Compression drop-down menu. 

 

Figure 4.2.24 Setting compression 

• Save your Nuke script by pressing Ctrl-S. 

• Click the Render button from the Render panel. 
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Figure 4.2.25 Rendering process 

 4.2.11 Creating Animation 

Key frames specify that you want animation. To do this, the property needs to change its value over 

time. So if you want your image to have a Blur value of 20 to begin with and then, at frame 10, to 

have a value of 10, you need to specify these two pieces of information: a value for frame 1 and a 

value for frame 10, and the application will interpolate the in-between values. 

• Go to desired frame from the Timebar. 

 

Figure 4.2.26 Timebar 

• Select Grade1 and press G on the keyboard to create another Grade node. 

• In Grade2’s Properties panel, click the Gain property’s Animation menu and choose Set Key. 
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Figure 4.2.27 Setting Gain properties 

• Advance one frame by hovering over the Viewer and pressing the right arrow on your 

keyboard. 

• Play with the Gain slider until you reach a result that matches the  brightness to that of the 

background. 

• Advance another frame forward to frame 44 and adjust the gain again. 

• Repeat the process for frames 45 and 46 as well. 

• Choose Curve Editor from the Gain property’s Animation menu. 

 

Figure 4.2.28 Curve editor option 

• Click the Node Graph tab to go back to the DAG. 
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Figure 4.2.29 Nodes prepared for animation 

• Click the Play button in the Viewer. 

You can find free video tutorials on Nuke at following link: 

https://community.foundry.com/playlist/1050/nuke-basics-nuke-feature-based-tutorials 
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Exercise  
1. Discuss the types of Matte used in compositing. 

 

 

 

 

  

2. What are the common operations performed for refinement of the matte? 

 

 

 

 

 

3. Discuss the despill operation. 

 

 

 

 

 

4. What are the four common elements of compositing? 
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5. What is node in Nuke software? 

 

 

 

 

 

6. What is the function of Nuke process tree? 

 

 

 

 

 

7. What are the common operations performed for refinement of the matte? 

 

 

 

 

 

8. Discuss the procedure of loading images in Nuke and then merging them? 
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Compliance at Workplace 

Unit 5.1 – Safety, Health, and Hygiene 

Unit 5.2 – First Aid 
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Key Learning Outcomes 

At the end of this module, you will be able to: 

1. Apply the current health, safety, security policies and procedure of organization.  

2. Perform the safe working practices pertaining to own occupation.  

3. Apply the government rules and policies related to the health and safety including emergency 
procedures for accidents, illness, fires or others.  

4. Identify the person responsible for health and safety in the working area, including those 
persons whom to contact in emergency.  

5. Use the security signals in the workplace like fire alarms, staircases, fire warden stations, first aid 
and medical rooms.  

6. Avoid the possible work hazards in the working area which can cause risk to others health and 
safety.  

7. Maintain own and other’s health and safety in the workplace through precautionary measures.  

8. Recommend the basic terms and opportunities to the designated person of your workplace for 
improving health, safety, and security.  

9. Correct the cause of accidents, illness, and fires in your working area and within the limits of 
individual’s authority.  
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UNIT 5.1: Maintain Workplace Health and Safety 

 

Unit Objectives 

At the end of this unit, you will be able to:  

1. Apply the current health, safety, security policies and procedure of organization.  
2. Maintain own and others’ health and safety in the workplace through precautionary 

measures.  
3. Recommend the basic terms and opportunities to the designated person of your workplace 

for improving health, safety, and security.  
 

5.1.1 Introduction 

Emergency evacuation is needed when staying within the building not safe anymore. Every 

organization has an evacuation procedure. Every organization has a safe place within the 

organization compound or outside the organization compound where all employees are expected to 

assemble in case of an emergency evacuation. The team leader guides the team and takes them to 

safe place. It is very important in these cases, to assemble at the safe area immediately.  

If you do not reach the safe area on time, the team leader who is responsible for your safety will 

send someone to look for you. This will put the other person's life in danger. 

Conditions for Evacuation  

Emergencies which require immediate evacuation includes:  
• Explosions  

• Fires  

• Earthquakes  

• Hurricanes  

• Floods  

• Workplace violence  

• Toxic material releases  

• Tornadoes  

• Civil disturbances  

 

Every company has:  
• An evacuation policy. All the TLs are responsible for informing their employees about it. 

When the TL is informing you about these details, pay attention. This negligence could cost 
lives.  

• A designated place for emergencies. Ensure that you know where it is.  
• A “buddy system” for individuals with special needs or disabilities. If you are a buddy to 

someone, ensure that your buddy is safely out of the premises with you.  
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Figure 5.1.1 Conditions for evacuation 

• Floor plans with evacuation routes in work areas. Ensure that you understand it so that you 
can use it in time of need.  

• Assembly areas. These are the areas where you are required to assemble after evacuation.  
• Periodic evacuation drills. Ensure that you pay attention during those drills. You need to 

save your life and you can be helpful in saving someone else’s life too.  
 

5.1.2 Mock Drills/ Evacuations 

The responsibility of the safety of the workers in case of emergency is on the fire safety and 

evacuation workers. These workers need to go through the training to know the duties and 

responsibilities. In a workplace, the practice drill should be done in every 3 months under simulated 

fire conditions so that the workers know the techniques of saving their and other life. By practicing 

in the fire drills, all the workers area able to know the lifesaving method required in case of 

emergency. 

Fare the exercises designed check the staff response as per emergency. It is also a test of the 

emergency staff, working staff and other members of fire safety department. Sometime the drill is 

not successful but that’s okay because human learn from previous mistakes. But it is important for 

all the members that they correct their mistake on time. Sometime all the mistakes were not done 

by the members of staff, the mistake is done the faulty equipment and safety plans. But, there is a 

need of staff training periodically. 
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Figure 5.1.2 Mock Drills 

There are two vital components for preparing the fire safety plan which are written below:  
1. An emergency action plan, which tells the procedure to be optimize in case of emergency.  

2. A fire prevention plan, which tells the methods to be optimize to cool the fire as soon as 
possible.  

 
You need to participant in arranged by organization for your personal safety and also for others 

safety. These drills help you in understanding the 

Fire safety and evacuation plans sketch staff duties and accountabilities in time of emergency. 
Continuing training is required to help safeguard that the employees are conscious of those duties 
and responsibilities. Firefighting trainings serve as an prospect for staff members to validate, under 
replicated fire conditions, that they can perform those duties and responsibilities safely and 
efficiently. It’s also a time for the workers or employee to demonstrate about the defend-in-place 
strategies and also the workers are able to take advantage of facility’s fire protection features and 
exit facilities to protect the people in their care.  

Fare excellent exercise designed to evaluate staff response to a replicated emergency. The fare is 
also a test of facility’s fire safety/evacuation strategies and staff training programs. It is not essential 
that all frun smoothly. That’s okay, so long as staff and the organization understand from them and 
correct mistakes made. It’s vital, therefore, that there be a analysis of each drill so that any 
problems met can be addressed. Perhaps the problems are due to unfinished or out-dated fire 
safety/emigration plans. Perhaps there’s a need for further training of staff.  

The two essential components of a fire preparedness plan are the following:  
1. An emergency action plan, which details what to do when a fire occurs.  
2. A fire prevention plan, which describes what to do to prevent a fire from occurring. 

 

5.1.3 Medical Emergencies 

Everyone plans for emergencies. That is the reason why we keep a first aid kit with ourselves. At 

work, however one is exposed to a lot of stress and physical activity. This could lead to certain 

medical emergencies. It’s better to be prepared with the first aid measures and knowledge of 

implementing them on ourselves and on others. This module equips you with that information. Pay 
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attention to these medical emergency procedures to understand how to conduct you in theses 

crucial movements. Pay attention during these sessions. You might be able to save your own and 

your friend lives. 

5.1.3.1 In case of Medical Emergency 

A medical emergency is a situation in which a worker met in accident and needs medical help. The 
medical injury may be severe or life threating. Some situation where:  

• Person is not inhaling  
• Heart attack or stock  
• Heavy or severe bleeding  
• Electric Shock  
• In case of Poisoning  
• Person get somebody Burns  

 

In case of medical emergency, the person or victim requires the immediate help. Sometime the 
person need attention before the you call the emergency helpline.  

It is important to know or remember the number of emergency helpline or Emergency Medical 
Service (EMS) for the safety of self and other workers.  

DON'T  
• Let the victim to eat or drink anything.  
• Confine the victim  
• splash any fluid on victim face or on injury.  
• shift the victim to another area or place unless it is the only way to protect the 

victim.  
 

Bleeding  
• Apply any type of pressure on the wound of victim with the help of bandage or any other 

means.  
• Elevate the wound to slow the bleeding.  
• When necessary, apply the pressure on pressure points near wound to block excess 

bleeding.  
 

Fainting  

 
• Fainting is a loss of consciousness which is due to temporary reduction flow of blood in the 

victim's brain.  
• The unconsciousness of the victim may led to more injury in the workplace.  
• Slow pulse of the victim.  
• The pale, cold skin and sweating of the victim.  

 

Causes of fainting:  
• Eating or drinking lack of fluids which is also known as dehydration. 
• The low blood pressure of victim. 
• Due to lack of sleep. 
• Over exhaustion of the worker 
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First Aid for Fainting:  
• Lie down the victim on the back and raise the legs above his heart level.  
• Ensure the clearance of victim's nose.  
• Check for indication of coughing, or breathing problem.  
• Loose the tight cloths like neck ties, collars, and belts.  
• If the victim remains unconscious from the 1 minute, call the EMS as soon as possible.  

 

Shock  

The shock occurs in the human body on the failure of circulatory system. When insufficient amount 
of oxygen is reached in the body tissue, the shocks also occur. This condition is treated as soon as 
possible if not, it may lead to organ failure, and may cause death. Shock becomes worse by fear and 
pain of victim.  

First Aid for shock:  
• If possible, keep the victims in lying down position.  
• Raise the legs 10-12 inches from the ground level unless you suspect a injury in back and 

bone.  
• If the victim is feeling cold then cover him. If the victim is feeling hot then don’t make 

suffocation by covering him.  
• If the victim starts vomiting then move the victim to the suitable place.  
• Loosen the tight clothing.  

 

Muscle Cramps  
• Stretch out the affected muscle of the victim to counterbalance the cramp part of the body.  
• Firmly massage the cramped muscle.  
• Apply some kind of moist heat on the affected area.  
• If the cramp remains in the muscle, get medical help as soon as possible.  
• Rest- avoids movements and activities that cause pain.  
• Apply the ice on the cramped muscle it may reduce the pain and swelling of the muscle.  
• Applying the light compression like elastic bandage on the affected area may reduce the 

swelling.  
• Raising the affected area above the heart level may reduce the swelling as well as pain.  

 

Fractures  

As we all know about the fracture that is the crack or break in the bone.  

Dislocation  

A dislocation occurs when the bone slips out from the specified location. It generally occurs in the 
shoulders, thumb, elbow, fingers, lower jaw and other movable joints.  

First Aid for Dislocations & Fractures:  
• Immobilize the effected part.  
• Stabilize the effected part  
• Use a cloth as a sling.  
• Use board as a sling.  
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5.1.4 First Aid 
First aid is the assistance given to any person suffering a sudden illness or injury with care provided 

to preserve life, prevent the condition from worsening, or promote recovery. 

Kits vary in contents but most kits have the following items:  

• Band-aids / Adhesive bandages  
• Gauze pads and tape  
• Scissors, cold pack  
• Wound bandage / compress  
• Eye pads / eye wash solution  
• First aid / burn cream  
• Antibiotic ointment  
• Face shield or barrier mask for providing CPR  
• Forceps / tweezers  
• Disposable thermometers  

• First aid instruction booklet 

 .1.  Personal Protective Equipment’s (PPE) 

Personal protective equipment (PPE) refers to protective clothing, helmets, goggles, or other 

garments or equipment designed to protect the wearer's body from injury or infection. The safety 

by protective equipment includes electrical, heat, physical, biohazards, chemicals, and airborne 

particulate matter.  

 

Figure 5.1.3 Personal Protective Equipment’s 
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In the workplace, there are many situations which require immediate first aid to the victim and 

many countries have made some regulation, legislation, and guidance which specify the minimum 

level of first aid to be given to the victim. For this, the worker needs the special training and area for 

achieving the immediate first aid. Go achieve this, the training should be given by specialist first aid 

officer and necessary training given by learning institute. The training of first aid does not need any 

type of specific tools and equipment but may involve the improvisation with material offered at the 

time of training. 

 

Figure 5.1.4 First Aid pyramid 

While delivering First Aid always remember:  

• To prevent from degradation.  

• Act deliberately and confidently with the victim.  

• The timings of Golden Hour should be first 60 minutes from an accident.  

• The timings of Platinum Period should be first 15 minutes following an accident.  

• Prevent the body shock and choking.  

• Stop bleeding from the wound.  

• Loosen the clothes of victim.  

• Regulate the respiratory system of the victim.  

• Avoid crowding near the victim.  

• Take the victim to safe place or hospital near the workplace.  

• Attend the emergencies situation with ease and without fear.  

• Always remember to not overdo. Because the person giving the first aid is not doctor.  
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Exercise  
1. Discuss some general safety rules for working in the workshop. 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. What is PPE and are the common components of PPE? 
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3. What is an accident and what are the types of accidents? 

 

 

 

 

 

 

 

 

 

 

4. Discuss the types of fire-extinguisher and their uses? 

 

 

 

 

 

 

5. Write a short note on health and hygiene? 

 

 

 

6. What are the common components of First-Aid kit? 
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7. What are the symptoms of shock and what should be the first-aid? 

 

 

 

 

 

 

 

 

8. What are the symptoms of heat exhaustion and what should be the first-aid? 
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